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Chapter 1: Installation of communication control and 

waveform analysis software of digital storage Oscilloscope 

1.1 Hardware requirements 

Device requirements  Minimum requirements  

Oscilloscope       PDO-5000S digital storage oscilloscope 

Computer         Windows 2000/XP/Vista system, 128 megabytes of RAM,  
16X CD-ROM or better (see corresponding hardware 
requirements of the Vista system), a 1024*768 or better 
resolution 

Connecting line     USB/HOST interface lines at two ends 

1.2 Installation of software 

A piece of communication control and waveform analysis software of digital storage 
oscilloscope (“software” for short) will be provided with the PDO-5000S digital 
storage oscilloscope (“oscilloscope” for short) you buy (the software is on the CD 
provided with the oscilloscope). 
Software name: PDO-5000S digital storage oscilloscope real-time monitoring 
software 

Installation steps: 

Step 1: Insert the CD provided with the oscilloscope into the CD-ROM of a computer 
that will read content of the CD. Find the software (Fig.1-1). 

 
Fig.1-1 

Notes: 
1. It is the installation package of the software downloaded from the website. It shall 
be decompressed before use. 
2. The software supports the Windows 2000 system, the Windows XP system and the 
Vista system; however, it supports the USB2.0 communication protocol on the Vista 
system only. 

 
Step 2: Double left click the mouse to run the installer of the software as shown in 

Fig.1-1. An installation preparation interface of the software as shown in 
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Fig.1-2 will then pop up automatically. 

 

Fig.1-2 
The system will then enter the installation wizard as shown in Fig.1-3. 

 

Fig.1-3 
 

Step 3: Read the prompt in Fig.1-3 and click Next (N) to enter the next step. See 
Fig.1-4. 
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Fig.1-4 

Step 4: In Fig.1-4, click Change (H), appoint an installation path for the software and 
click Next (N); or click Next (N) directly, use the default path and click 
Install to enter the automatic program installation interface. See Fig.1-5. 



                    Page   of 41 
User’s Manual of Oscilloscope Communication Control Software 

7 

 

Fig.1-5 
Step 5: After automatic program installation, an interface as shown in Fig.1-6 will 

pop up. Click Finish (F) to finish installation of the software on the 
computer. 
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Fig. 1-6 
To return to the installation wizard interface of the last step during installation, 

just click Back (B) on any installation wizard interface. 
To stop installation, just click Cancel (C) on any installation wizard interface to 

exit installation wizard of the software. 

Installation of software driver 

To realize communication control between the oscilloscope USB interface and 
the software after the software is installed, it is necessary to install a USB driver. 

1.3.1 Manual installation 

Steps: 
Step 1: Insert the CD provided with the oscilloscope into the CD-ROM of a 

computer that will read content of the CD. Find the DSO New Driver in the folder for 
driver installation (Fig.1-7). 

 

Fig.1-7 
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Step 2: Double click DSO New Driver to run it. An installation prompt (Fig.1-8) will 
then pop up. Click NEXT to enter the automatic program installation interface. 

 
Fig.1-8 

 
Step 3: After automatic program installation, an interface as shown in Fig.1-9 will 

pop up. Click Finish (F) to finish installation of the USB driver on the 
computer. 
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Fig.1-9 
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Chapter 2: Preliminary understanding of structure of 

the software 

2.1 Overview of panel of the software 

After the software is started, a display panel similar to user interface of the 
oscilloscope and called virtual oscilloscope panel will pop up. During data 
transmission, you can observe current waveform of the oscilloscope through virtual 
display of the virtual oscilloscope panel and view such information of the waveform 
and the channels as parameters through menus and controls of the user interface. 
Specific use will be introduced in detail below. 
 
 

 
 

Fig.2-1 

2.2 Menu description 

You can start and exit the software through the menus on upper left of the display 
in Fig.2-1. There are two menus in all, including Home and View. The two menus are 
described as below. 

2.2.1 Home 

General control buttons and knobs of the oscilloscope are saved under the Home 

Menus and virtual control panel Virtual display Oscilloscope menus 
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menu. The Connect button is used for establishing correct communication 
between a computer and the oscilloscope. 

2.2.2 View 

After the check boxes in front of Parameter Measurement, Current State, and Save are 
ticked, relevant menus will pop up on corresponding positions of the display and be 
displayed in a list according to the three categories above. The menus may be placed 
in any positions of the display. If some menus are stratified, labels for menu category 
change will be automatically generated below the stratified menus. See Fig.2-2. 

 
Fig.2-2 

The oscilloscope can be operated through the software. In a remote monitoring 
mode, the software shows the oscilloscope menus through a list for quick parameter 
setup. Corresponding shortcuts of some general buttons and knobs have been placed 
under the Home menu. 
Each option in the menu list corresponds to a menu option on the oscilloscope. User 
may move the mouse to the corresponding menu, click or double click the “ ” sign 
on its right side and choose relevant parameter from the list appearing after that to 
execute the corresponding function. For good control of this sort, user must be 
familiar with each menu and the current state. The waveform on the virtual display is 
updated in real time and is synchronous with the waveform displayed on the 
oscilloscope. 
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Chapter 3: Operation guide for software 

3.1 Start the upper computer program and connect the lower 

computers 

3.1.1 Establish the hardware environment 

Power on the lower computers and connect the computer with the DSO by a USB cable 

corresponding to the model. 

3.1.2 Start the software 

  
After the software is installed, it may be started on your computer in either way 
below. 
1. After the software is installed, a shortcut icon (Fig.1-11) for it will be automatically 
generated on the computer desktop. The software can be started by means of double 
left click on the shortcut icon. 

 

Fig.3-1 
 

2. The software can also be started by clicking Start, Program, DSO, and DSO 
Real-time Monitoring in order. See Fig.1-12. 
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Fig.3-2 
3. Choose the corresponding model of your oscilloscope from the dialog box and click 
OK to enter the upper computer interface (Fig.3-3). 

 
Fig.3-3 

4. When the software is started, the oscilloscope will be connected automatically. If 
the connection fails, check and make sure the oscilloscope and the computer are 
correctly connected and the oscilloscope has been powered on and click Connect on 
the software. The correct connection is shown in Fig.3-4. 
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Fig.3-3 

3.2 Functions of software 

3.2.1 Function of the Home menu 

General control buttons and knobs of the oscilloscope are saved under the Home 
menu. The Connect button is used for establishing correct communication between a 
computer and the oscilloscope. See Fig.3-4. 
 

 
Fig.3-4 

3.2.1.1 Basic control 

1. RUN 

Function: Corresponding to the Run button of the oscilloscope, it is used for setting a 
running status for the oscilloscope. 
2. STOP 

Function: Corresponding to the Stop button of the oscilloscope, it is used for setting a stop 
status for the oscilloscope. 
3. AUTO 

Function: Corresponding to the Auto button of the oscilloscope, it is used for setting an 
automatic setting status for the oscilloscope. 
4. CH1 
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Function: CH1 shortcut 

5. CH2 

Function: CH2 shortcut 

6. MATH 

Function: MATH shortcut 

7. FORCE 

Function: It is the FORCE button that is a forced trigger button. 

8. SINGLE 

Function: It is the FORCE button that is a shortcut for single trigger. 

3.2.1.2 Return-to-zero shortcut 

1. Pre-trigger return-to-zero 
Function: It makes pre-trigger returns to zero quickly. 

2. Trigger level return-to-zero  

Function: It makes the trigger level returns to zero quickly. 

3. CH1 vertical return-to-zero 

Function: It makes the CH1 vertical position returns to zero quickly. 

4. CH2 vertical return-to-zero 

Function: It makes the CH2 vertical position returns to zero quickly. 

3.2.1.3 Gear control 

1. Volt/div gear control 
Function: It increases or decreases the volt/div gear. 

2. Time base gear increase/decrease control 

Function: It increases or decreases the time base gear. 

3.2.1.4 Communication connection 

Function: When a lower computer is not connected with the upper computer, click this button to 

connect it. 

3.3.2 Functions of the View menu 

After the check boxes in front of Parameter Measurement, Current State, and Save are 
ticked under the View menu (Fig.3-5), relevant menus will pop up on corresponding 
positions of the display and be displayed in a list according to the three categories 
above. The menus may be placed in any positions of the display. If some menus are 
stratified, labels for menu category change will be automatically generated below the 
stratified menus. See Fig.3-6. 
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Fig.3-5 

 

Fig.3-6 

3.3.2.1 Current status 

Function: If the Current Status option is ticked, a current status window (Fig.3-7) will pop up. 

 

Fig.3-7 

In the window, all setting operations consistent with the lower computers can be done. 

3.3.2.2 Parameter measurement 

Function: If the Parameter Measurement option is ticked, a parameter measurement window 

(Fig.3-8) will pop up. 
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Fig.3-8 

If the Open option is ticked, the parameter measurement function will be enabled and various 

measured parameter values will be obtained in real time. See Fig.3-9. 

 

Fig.3-9 

3.3.2.3 Save 

Function: If Save is ticked, a saving window (Fig.3-10) will pop up. 
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Fig.3-10 

In the window, there are three saving types (Fig.3-11) for choosing. 

 

Fig.3-11 

3.3.3.1 Record waveform 

Function: It can record the waveform in the current status for analysis. See Fig.3-12. 



                    Page   of 41 
User’s Manual of Oscilloscope Communication Control Software 

20 

 
Fig.3-12 

Choose the saving path: Saving position of the waveform data recorded can be set here. 

Time interval: The time interval of waveform recording, i.e. the time interval of frame recording, 

can be set here. 

After both the saving path and the time interval are set, click Start to start recording the waveform 

as set. Information such as the frames recorded, the duration of recording, the frame rate and the 

complete path of the file will be displayed in real time below. See Fig.3-13. 
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Fig.3-13 

If Stop is clicked, waveform recording will stop. 

If Playback is clicked, the software will be started for playback of the waveform recorded. For 

more details, see function description of the software. 

 

3.3.3.2 Screen capture 

Function: 

If Screen Capture is chosen, you can set a saving path for the screen captured and then click Save. 

After that, a prompt reading “Saving completed” will appear. See Fig.3-14 and Fig.3-15. 
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Fig.3-14 

 

Fig.3-15 

The designated position where the bitmap is saved can be opened after “Open the folder” is 

clicked. See Fig.3-16. 

 

Fig.3-16 

 

3.3.3.3 Save waveform data 

Function: It is used for saving waveform data in the current status of the oscilloscope. 

If the saving path is changed, the waveform of “*SAV” format can be saved to a designated 
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position. See Fig.3-17. 

If Save is clicked, the waveform data file of “*SAV” format will be saved to a designated position. 

If Open is clicked, the software will be started. In the software, detailed information of the 

waveform is available. 

If “Open the folder” is clicked, specific position of the waveform data file of “*SAV” format will 

be opened. 

 

Fig.3-17 

3.3.3.4 File Handling 

Description: Recording and scan recording oscilloscope waveforms for upload to PC, or uploaded 

to scan recording waveform recording and re-download the file on your PC to the oscilloscope.  

Waveforms on an oscilloscope or scan recording after recording, do not keep the oscilloscope 

power, connect the oscilloscope and PC. When you first open the PC, you'll be prompted in the 

following figure: 

 

Fig.3-18 

Select "Yes (Y)", the pop-up menu REC file processing. As shown in Figure 3-19: 
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Fig.3-19 

Click the symbol can be set to upload the file storage path REC. After setting the path, click the 

"Upload" button, or scan the data recorded waveform recording (REC files) uploaded to the PC. 

REC file so it can be a long-term preservation.  

After you click the symbol and select the downloaded file, select the file, click good 
"download" button, the REC files stored on the PC to download to the oscilloscope. This can save 

a good REC files to reproduce on an oscilloscope. 
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Chapter 4: Operation guide of software 

The software is mainly used for saving the waveform acquired by the 
oscilloscope onto a computer for analysis and processing. It has functions such as 
cursor measurement, waveform zooming and data point export, making it convenient 
for user to process the waveform later. 

After the software is started, a display panel called virtual display will pop up. 
After the data are opened, user can observe and analyze the waveform saved by the 
oscilloscope through the virtual display. 

The software supports the files of SAV or REC format. 
Note: The files of “* SAV” format show the single-frame waveform data information saved 

by the oscilloscope; the files of “* REC” format are the multi-frame waveform data files recorded 

by the oscilloscope. 

The software can realize detailed parameter analysis, mathematical operation and zooming 

for the waveform of SAV format and looped playback, stop, pause and single-frame playback for 

the waveform of REC format. 

4.1 Start of software 

After the software is installed, it may be started on a computer in any of the following 
three ways. 
1. After the software is installed, a shortcut icon (Fig.4-1) for it will be automatically 
generated on the computer desktop. The software can be started by means of double 
left click on the shortcut icon. 

 
Fig.4-1 

2. The software can also be started by clicking Start, Program, DSO, and Waveform 
Analysis in order. See Fig.4-2. 
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Fig.4-2 
3. The software can also be started by clicking “Start the waveform analysis program” 
in the menu on upper left of the software interface. See Fig.4-3. 

 
 

Fig.4-3 
Fig.4-4 shows the software interface. 
 

 
Fig.4-4 

Virtual display Menu and shortcut bar 
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4.2 Menus of software 

In Fig.4-4, the main menu on upper left of the display includes five submenus 
including File, View, Analyze, Playback and Help. The five submenus are introduced 
below. 

4.2.1 File 

Open: It is used for reading the waveform file saved on a computer hard disk or 
another storage medium to the software. Choose “File” and “Open” in order to 
upload a file of “*.sav” or “*.rec” format to the software. 

File information: Through the file information bar, statuses of the oscilloscope 
during waveform saving can be clearly seen so that the conditions during 
waveform saving can be reproduced easily. See Fig.4-5. 

 

Fig.4-5 

Export data: It is used for exporting the current data of “*.CSV” format on the 
software to a computer hard disk or another storage medium. See Fig.4-6. 
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Fig.4-6 

Exit: It is used for exiting from the software. 

4.2.2 View 

For the imported data of “*.rec” format, there are only a tool bar and a status bar 
under the View menu. 
Original: It displays the most original data of “*.sav” format recorded from the 

oscilloscope. 

Filter (contrastive /separate): Only when the imported waveform has been filtered 
under the “Analyze” menu can this function be enabled to display the 
waveform filtered in a separate or contrastive (to the original waveform) way. 

FFT: Only when FFT operation has been done for the imported waveform under the 
“Analyze” menu can this function be enabled to display the waveform once 
receiving FFT operation. 

Zooming mode: It is used for zooming in the waveform on the virtual display along 
different axial directions. To zoom in the waveform along the X axis, press 
and hold the left mouse button in the waveform display area, transversely drag 
the mouse to choose the area for zooming in and release the left mouse button 
to zoom in the chosen area along the X axis. 

Measurement mode: The time difference (△t) and amplitude difference (△V) of two 

cursors can be measured through the cursor function. Move the mouse to a 
cursor, press and hold the left mouse button while dragging the cursor, read 
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difference of the coordinate axes and calculate the time difference (△t=|x1-x2|) 

and the amplitude difference (△V=|y1-y2|). 

Too bar: If “Standard” and “Playback” in the tool bar are ticked, a shortcut bar will 
be displayed below the menu bar. 

Status bar: If the mouse is moved to a shortcut icon or menu, relevant information 
currently indicated by the mouse will be displayed in the status bar on lower 
left of the virtual display. The display can be closed here. 

4.2.3 Analyze (effective for the data of “*.SAV” format) 

Measure: It is used for measuring such parameters of the imported waveform as 
amplitude, frequency, pulse width and duty ratio. See Fig.4-7. 

 

Fig.4-7 

FFT: It is used for realizing Fourier transformation for the imported waveform. The 
window functions for choosing including Blackman, Hamming, Hanning and 
Rectangle. See Fig.4-8. 
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Fig.4-8 

After an appropriate window function is chosen, click OK. The original waveform data will be 

then transformed into FFT waveform data. See Fig.4-9. 

 

Fig.4-9 

To restore the original waveform data, click the Original option under the View menu. See 

Fig.4-10. 

 

Fig.4-10 



                    Page   of 41 
User’s Manual of Oscilloscope Communication Control Software 

31 

Filter: It is used for filtering the imported waveform to filter the signals beyond the 
cutoff frequency band. There are three filtering types including band-pass, 
high-pass and low-pass for choosing. See Fig.4-11. 

 

Fig.4-11 

After the filtering type, the upper frequency limit and the lower frequency limit are set, click OK. 

The waveform data obtained after filtering will be displayed in the software. See Fig.4-12. 

 

Fig.4-12 

4.2.4 Playback (effective for the data of “*.REC” format) 

Play/Stop/Pause: It is used for playing, stopping and pausing an imported recorded 
waveform data (*.REC) file. 

Single-frame play: If the “▲” button or “▼” button in the red box in Fig.4-13 is clicked, 

single-frame play of the waveform data will be realized. 
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Fig.4-13 

4.2.5 Help 

About: It is used for displaying relevant version information of the current software. 

4.3 View properties of the current frame  

4.3.1 Measurement mode 

After the SAV waveform data are opened, you may click in the tool bar and right click 

the mouse in the waveform display area to enter the measurement mode. See Fig.4-14. 

 

Fig.4-14 

In the measurement mode, measurement and analysis of the SAV waveform data can be realized 

through the cursor lines. See Fig.4-15. 
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Fig.4-15 

The two vertical red cursor lines can be dragged by the mouse. Voltage and time related 

parameters will be displayed on the lower left corner in real time in the process. 

4.3.2 Zooming mode 

There are three zooming modes including zooming in along the X axis, zooming in along the Y 

axis and zooming in along both the X axis and the Y axis. See the three buttons in the red box in 

Fig.4-16. 

 

Fig.4-16 

After resetting, the 100% view will be restored. 

 

Fig.4-17 

4.3.3 View properties of the current frame 

After a file of “*.SAV” or “*.REC” format is opened, right click the mouse in the waveform 

display area. Option “View properties of the current frame” will then pop up. Fig.4-18 shows an 

example of a file of “*.REC” format. 
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Fig.4-18 

After “View properties of the current frame” is clicked, window showing information of the 

current frame will pop up to display waveform parameter information of the current frame. See 

Fig.4-19. 

 

Fig.4-19 

4.4 Application example 

1KHz/3Vpp square wave signal data (*.SAV) are uploaded to the software and 
then filtered by a band-pass filter with an upper frequency limit of 10KHz and a lower 
frequency limit of 100Hz. The virtual display shall display the filtering waveform 
only. 
a. Start the software with the method introduced in section 1. 
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b. Choose File and Open in order in the menu and choose the waveform file through 
the correct path. See Fig.4-8. 

 
Fig.4-20 (a) 

 
Fig.4-20 (b) 
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Fig.4-20 (c) 

c. Choose Analyze and Filter in order in the menu, choose Band in the filter type 
column in the filter parameter setup dialog box, set the upper frequency limit and the 
lower frequency limit to be 10KHz and 100Hz, respectively, and click OK. See 
Fig.4-9. 

 
Fig.4-21 (a) 
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Fig.4-21 (b) 

d. Choose View and Filter (separate) in order in the menu to view virtual display of 
the software. See Fig.4-22. 

 
Fig.4-22 
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Chapter 5: System prompt and troubleshooting 

5.1 System prompt information 

Wrong device connection or model: Check whether the oscilloscope model and the 
communication interface type are correct, whether the device is correctly connected 
and whether the software driver has been updated. 

5.2 Troubleshooting 

1. If a device connection failure is prompted after the Connect Device button is 
clicked, handle it with the steps below. 
 
 (1) Check whether power connection of the oscilloscope is correctly connected. 
 
 (2) Check whether the oscilloscope and the software are correctly set. 
 
(3) Check whether the cable between the module and the computer is correctly 
connected. 
 
 (4) Check whether the USB driver is correctly installed. 
 
 (5) If the result of each check above is right, start and run the software and the 
oscilloscope again before further operation. 
 
2. If the software driver cannot be updated, operate with the steps below: 
 
 (1) On the computer desktop, right click the mouse as shown in Fig.5-1. A right 
button menu as shown in Fig.5-2 will then pop up. 

        
Fig.5-1                            Fig.5-2 

 (2) In Fig.5-2, choose Properties and right click the mouse. A window as shown in 
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Fig.5-3 will then pop up automatically. 

 
Fig.5-3 

 (3) In Fig.5-3, choose Hardware. A window as shown in Fig.5-4 will then pop up. 

 
Fig.5-4 

 (4) In Fig.5-4, choose Device Manager (D). A window as shown in Fig.5-5 will then 
pop up automatically. 
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Fig.5-5 

 (5) After “USB Device” is unloaded from “libusb-win32 devices” in Fig.5-5, Again  
run the oscilloscope again and choose “Update driver automatically” to finish driver 
update. 
 
 
 
 
Remarks: Don’t unplug the communication cable directly during communication 
between the software and the oscilloscope; otherwise an unexpected phenomenon 
may appear. 
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Thank you! 
 
 
 
 
 
 
 
 
 
 
 
 
 


